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Axial HPT blade 

Note:  

In this tutorial, an axial gas turbine geometry, including all the secondary hub and shroud flow paths 
and the internal cooling geometry, is prepared for analysis. 

This tutorial demonstrates the concepts of a cylindrical Bounding Box, and hence the creation of an 
octree mesh based on polar cylindrical coordinates. There are multiple patch refinements based on 
local curvature and facet edge angle, and also the use of polylines to identify regions for refinement 
and viscous layer mesh.  

Import the geometry from the NX CAD part hpt_blade.prt  

• File > Import Part from the menu bar, OR  

• Click the Import Part toolbar button, OR  

• Use the keyboard shortcut Ctrl-G. 

• Select the NX file hpt_blade.prt and press the Open button (or double click on the part 
filename). 

• The Import CAD Wizard window appears, progress is shown as the file loads and then the 
Import CAD Wizard becomes active. 

• Select the following options from the Import CAD wizard: 

For Face assignment, select Colour and Parts, ensure  All Faces is unselected 

(Part Attribute and Face Attribute are not available in this particular model).  

 Leave the Curvature resolution sliders in their default positions.  

 Enable the STL-style radio button.  

 Select the Max. Chord Error option and enter a value of 0.1.  

 Uncheck  Simplified ASCII Names ,check Merge Duplicate Attributes 

 In the Select Layers list, check only layers 1, 5 and 6. 

• Click OK to complete the CAD import. 

The geometry is imported as a single part ("hpt_blade.prt") containing 13 patches. A default bounding 
box is set up using the Constraint: None option. 
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At this stage the individual patches have rather generic names based on part list, layer number and 
original colours used by the NX CAD system. It is useful to rename some of the patches. To rename a 
patch, RMB over the patch name in the Feature Tree and then LMB "Rename..." from the pop-up menu. 

• Rename hpt_blade_0_6_154_144_0 (1st in the patch list) as blade1 

• Rename hpt_blade_11_6_0_153_0 (2nd in the patch list) as blade3 

• Rename hpt_blade_4_5_125_125_125 (6th) as tip 

• Rename hpt_blade_4_5_153_102_51 (7th) as hub 

• Rename hpt_blade_4_5_173_167_211 (8th) as shroud 

• Rename hpt_blade_4_5_192_227_223 (9th) as shroud_fillet 

• Rename hpt_blade_4_5_210_106_55 (10th) as hub_fillet 

• Rename hpt_blade_4_5_255_0_0 (11th) as trailing_edge 

• Rename hpt_blade_4_5_255_0_255 (12th) as blade_surface 

• Rename hpt_blade_4_5_74_115_27 (13th in the patch list) as internals 

Rename other patches to more descriptive names if you wish 

Define a cylindrical Bounding Box  

This Bounding Box will span one pitch of the 68-bladed annulus in this particular example. By setting 
the Cylindrical option, BOXERmesh automatically sets the mesh on the theta-min and -max faces 

to be periodic and permits the fixing of the theta extent of the mesh.  

• Double-click the Bounding Box item in the feature tree, or click on the Bounding Box 

button in the toolbar to open the Bounding Box Editor. 

• From the Coordinate System menu picker, select Cylindrical. 

• Ensure that the θ-Periodic box is checked 
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• Set the Datum[x,y,z] as (500, -700, 10600).  

• Leave the Manual rBar box unchecked. 

• Set Corner 1 (x,theta,r) as (-1240, 0.4, 10200).  

• Set Corner 2 (x,theta,r) as (2500, -4.89411, 14200). 

• Set Number of Cells to 40.  

• Click OK to confirm the Bounding Box specification. 

The Bounding Box appears in the scene, subdivided by lines which illustrate the number of cells in the 
tangential direction specified.  The user could proceed and generate a mesh defined by this Bounding 
Box but this is likely to be in the region of 80m cells.  Instead, the Bounding Box is resized for this tutorial 
to keep the cell count manageable.  

• Double-click the Bounding Box item in the feature tree, or click on the Bounding Box 

button in the toolbar to open the Bounding Box Editor.  

• Set Corner 1 (x,theta,r) as (-500, 0.4, 12000).  

• Set Corner 2 (x,theta,r) as (1500, -4.89411, 12200). 

Use the RMB menu over the Bounding Box entry in the Feature Tree to hide, show and change the 
display type of the Bounding Box in the scene. 

Tip:  

With the Manual rBar checkbox unchecked, BOXERmesh automatically calculates an rBar value 

that is close to the middle of the domain in the radial direction. This is beneficial to the final mesh 
quality. 
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Define a Region inside the Bounding Box and also in the main gas path.  

• Create a Region and set its seed point coordinates to be (1000 -1000 12100). The default 
name of the first created region is "Region". 

• Click OK to confirm the Region specification. A Region entity appears in the Feature Tree, 

and the Region appears via its seed point as a quartered circle in the 3D scene. Turn off 
the visibility of the Bounding Box to see it clearly. 

 

Set the Blanketing depth  

• Open the Blanketing property editor, either by double-clicking it in the Feature Tree or by 
using the toolbar. 

• Untick Use Default, and enter 4 in the Layer Depth field. 

• Click OK to confirm the Blanketing specification. 

Set a "general" surface refinement level  

• Create a Face Refinement specifier for all the patches, at octree level 1.  

Note:  

In this example, most surfaces will have refinement greater than level 1. But we can create a "catch-
all" refinement specification like this to start with, because BOXERmesh uses the highest level of 
octree refinement (i.e. the dimensionally smallest mesh length specification) that is specified for any 
entity, ignoring any lower level (coarser mesh) that might be specified elsewhere.  
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Set Face Refinement on specific patches  

• Create a Face Refinement Specifier on patch "blade_surface" at octree level 2.  

• Create a Face Refinement Specifier on patches "internals", "hub", "shroud", "hub_fillet", 
"shroud_fillet", “blade1” and “blade2” at octree level 3. 

Set Edge Refinement on specific patches  

• Create an Edge Refinement Specifier on patches "internals" and "tip", at octree level 4 for 
edges with a minimum angle deviation of 30 degrees.  

• Create an Edge Refinement Specifier on patch "internals", at octree level 4 for edges with 
a maximum radius of curvature of 10.0.  

Create three polylines to enclose the surfaces around the blade leading edge and trailing edge

 

• Create a hollow Polyline called "lead"; with Inner Radius of 11200, Outer Radius of 

12850, using a starting point of (-100, 0, 0) and end point of (100, 0, 0). 

• Create a hollow Polyline called "trail"; with Inner Radius of 11400, Outer Radius of 

13100, using a starting point of (900,0,0) and end point of (1100,0,0). 

 

Note:  

The Polyline castellation error in the image below - piecewise-linear resolution of the cylinder 
boundaries - is only an artefact of the GUI rendering resolution and not of the Polyline data itself.  
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Use the Polylines as Face Refinement specifiers  

• Create a Face Refinement specifier using all the geometric patches and the Polylines 
"lead" and "trail", at octree level 3. 

Note:  

It doesn't matter that all the specified geometry doesn't intersect with the polylines. BOXERmesh 
automatically works out where the intersections between geometry and polylines occur, and applies 
the specified refinement at those surfaces only.  
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Create a global Layer Specification  

• Create a Layer Specification for all patches; using Layer Count as 4, Expansion 

Ratio as 1.2, and Initial Relative Step Size as 0.1.  

• Do not use the Perimeter Patch option. 

 

Define a feature capture angle  

• Open the Body-Fitted Mesh editor by clicking the Edit body-fitted mesh setup button on the 
toolbar. 

• Check the Feature Capture option is enabled. 

• Change the Angle to 30. 

• Click OK to confirm the Body-Fitted Mesh specification. 

Note:  

If saving the full mesh specification to a script file for later batch processing, the Body-Fitted Mesh 
Editor is used to supply the output mesh file name in the script - via the Save Mesh in Script 

checkbox and the Name field. 

Check basic cell sizing using the Octree Preview function  

• From the toolbar, turn on Octree Preview. 

• Indicative cubes appear, scattered across the surfaces to be meshed. The cubes are at 
the same length scale as will be the local octree mesh. 

• Zoom in to near the cooling holes, and check the local mesh length scale against the 
geometry hole diameter. Turn off visibility of the "blade_surface" part to see the holes 
more clearly. 
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Note:  

There are two length scales shown on the holes, one relating to a Face Refinement Specifier (level 
3) and one to an Edge Refinement Specifier (level 5). The smallest local cell size takes precedence, 
so in this case the Edge Specifier 'wins' near the holes.  

 

Generate and view the Octree Mesh  

• Click on the Generate Octree Mesh button in the toolbar (the button goes orange to 
indicate that BOXERmesh is busy) 

• When the octree mesh is complete, the Generate Octree Mesh button goes grey and its 
action is disabled to indicate that the octree is up-to-date. 

• The internal octree patches appear in the scene and also appear as features in the 
Feature Tree. 

 

mailto:info@boxersolutions.com
http://www.boxersolutions.com/


 

Page | 9  Axial HPT Blade 

info@boxersolutions.com  www.boxersolutions.com 

• Click on the Generate New Isosurface button in the toolbar, or go Insert > 

Isosurface to open the Isosurface Editor dialog.  

• Change the Mesh type to Octree, change the Cut Type to Isosurface and change the 

Iso Scalar to R Coordinate. 

• Enter an Iso Value of 12100 and click OK. A cut plane through the Octree volume mesh 

appears at R=12100. 

• The item Isosurface appears in the Feature Tree under Visualisation > 

Isosurfaces. To see it more clearly, turn off the visibility of all parts and octree patches; 

or RMB over Isosurface and select "Only" to remove everything from the view except 

Isosurface. 

• Enter different values of R Coordinate to "sweep" through the volume mesh. 

 

Generate and view the Inviscid mesh  

• Click on the Generate Inviscid Mesh button in the toolbar (the button goes orange to 
indicate that BOXERmesh is busy) 

• When the mesh is complete, the Generate Inviscid Mesh button goes grey and its action is 
disabled to indicate that the mesh is up-to-date. 

• The surface mesh patches appear in the scene and also appear as features in the Feature 
Tree. 

• Double-click on Isosurface in the Feature Tree to re-activate the Isosurface Editor for 

this feature. 

• Change the Mesh list picker from Octree to Body-Fitted, change the Cut Type to 

Crinkle and click OK. The visualisation changes to show a slice through the body-fitted 

mesh. 
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Generate and view the Layered mesh  

• Click on the Generate Layered Mesh button in the toolbar (the button goes orange to 
indicate that BOXERmesh is busy) 

• When the mesh is complete, the Generate Layered Mesh button goes grey and its action 
is disabled to indicate that the mesh is up-to-date. 

• The Isosurface updates and the layers can now be seen. 

 

Save the mesh (*.box) on the server filesystem  

• Go to Insert > Mesh Export and select BOX to open the BOX Mesh Export Editor 

dialog. Alternatively, click the Create new BOX mesh export specification icon 

on the toolbar. 

• Leave the name as default BOX Mesh Export. 

• Click on the disc icon to open a file browser. Navigate to the working directory, enter the 
filename hpt_blade_air and check the Automatically Save with File-

Extension (*.box) tick box. Click Save. 

• Ensure the Enabled tick box is checked. 

• Drag the region that contains the mesh ("Region") from the Feature Tree and drop it in 

the Exported Regions Subset in the BOX Mesh Export Editor. 

• Click OK to exit. 

• (Optional) Repeat the above to export the same mesh in an alternative format. 
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• Click on the Save all body-fitted mesh exports button in the toolbar, or 

• File > Save all mesh exports from the menu bar. 

• Check that you have a .box file. 

 

Save the geometry file (*.btf)  and the project file (*.bxr) on the client filesystem  

• Save from the menu bar, OR  

• Click on the Save Project icon on the toolbar, OR 

• Keyboard shortcut Ctrl-S. 

• The geometry must be saved before the project and a pop up window informs the user of 
this.  Click OK and save the the geometry (*.btf) file. 

• The Save Project As window now opens.  Click on the Project disc icon to open a 

file browser. Navigate to the working directory, enter a project filename and check the 
Automatically Save with File-Extension (*.bxr) tick box. Click Save. 

• If you wish to save a .bmf file then check the Mesh tick box. 

• Click on the .bmf disc icon to open a file browser. Navigate to the working directory, enter 

a .bmf filename and check the Automatically Save with File-Extension 

(*.bmf) tick box. Click Save. 

• Click OK to save the project file and .bmf file.  
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